Digital design laboratory 1




Introduction

* The goal of the laboratory is to provide an opportunity to use and test
the theoretical concepts you studied on lecture on a real hardware.

* For this purpose, we are going to use an FPGA board
* FPGA stands for Field-programmable gate array

 Fundamentally, the FPGA consists of a large number of logic blocks,
and the way these blocks are wired together can be defined by the
user

* In addition, the functionality of the logic blocks can be defined also
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* For example, a logic block can be used as a memory component, or it
can be used to do mathematical operations (e.g. adding two
numbers).

* FPGA-s can be configured using a hardware description language
(HDL).

* These languages have their own syntax, but it’s often quite similar to
traditional computer programming languages.
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 However, there is one very important difference between computer
programming languages and hardware description languages.

* In CPLs, the instructions are executed sequentially, one-by-one.

* In HDLs, the instructions are executed parallelly, more at the same
time.

* Let’s demonstrate this with a simple example.
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* Take a look at the following C code:
int a = 9, b = 0;
while (1) {
a =a+ 1;
b =a+ 1;

}

* First the memory is allocated for 2 and b, then the value of a is
updated with , then b’s value is set to
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» After the first cycle the the value of a will be 1 and the value of b will
be 2.

* In the nth cycle a will be n and b will be n+1 .

* The assignment of a always precedes the assignment of b, so these
two variables will never have the same value at the end of the cycles.
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* Take a look at the following Verilog code. Do not worry about the syntax (it is not
important now), this is the Verilog version of the above C code.

reg [31:0] a; // 32 bit registers for storing
reg [31:0] b; // integer data
always @ (posedge clk) // some condition, not important
begin
a <= a + 1;
b <= a + 1;
end

* Since Verilog evaluates the assignment simultaneously, a and b registers will
always have the same value.
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* The ISE Design Suite 14.6 software will be used on the laboratories to
design and implement digital circuits.

* To launch the application, click on the icon on the desktop:

e Or launch it from the Start menu:

e Start -> All Programs -> Xilinx Design Tools -> ISE Design Suite 14.6 ->
ISE Design Tools -> Project Navigator
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» After the navigator has started, it is time to create your first project.
 Select File, then New Project...

"™ I5E Project Navigator (P.68d) - C:hdigit!

| File Edit Miew Project Source  Proces:

U e Project.. 3
D

Open Prajeck. .. -+ [

Cpen Example. .. - @ Simul
Projeck Browser. .. =

E

Copy Project, ..

* The New Project Wizard appears. Next slide shows how to fill the
textboxes.

* General rule: always work on the D: drive!
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 Name: Digital _design lab 1

* Locaton and Working Directory:
D:\Digital design lab 1

e Description: this can be empty
* Top-level source type: HDL
* If everything is set, press Next.

B New Project Wizard

Create New Project
specify project location and byvpe.

—Enter a name, locations, and comment for the project

Mame: I Digital_design_lab_1

Location: I D\ pigital_design_lab_1

Working Directarsy: ID:'I,DigitaI_design_IaI:u_l

L

Descripkion:

—5Select the tyvpe of top-level source For the project

Top-level source type;

frox =]
Mare Info | Mext = Cancel |
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™ New Project Wizard

Project Settings
Specify device and project properties,

Set the following:
Family: Spartan3E
Device: XC3S250E
Package: TQ144
Speed: -4

Do not modify the other settings!
Press Next

—3elect the device and design flow For the project

Property Mame Yalue
E'valuation Development Eoard Mone Specified ;l
Product Cateqory: All ;I
Farnily Spartan3E ;I
Dievice RCASZ50E |
Package TO144 =
Speed -4 |
Top-Level Source Type HOL ;I
Synthesis Tool #3T (wHDLverilog) ;I
Simulatar ISim (YHDLVerilog) |
Preferred Language Werilog ;I
Property Specification in Project File Store all values ;I
Maral Compile Crder —
YHOL Source Analysis Skandard YHOL-93 |
Erable Message Filtering I

MDLIHFD' < Back, Mexk = Cancel
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"™ New Project Wizard

Project Summary

* The following window appears:
* Just press Finish

Projeck Mavigatar will create a new project with the Following specifications,

Project:

Project MName: Digital design lab 1

Project Path: C:HDigital_design_lah_l
Working Directory: C:HDigital_design_lah_l
Dezgcription:

Top Lewvel J3ource Type: HDL

Device:

Device Family: SpartansikE

Dewvice: xo3s250e
Package: tgldd
Speed: -4

Top-Lewvel Jource Type: HDL

SGynthesiz Tool: X3IT (VHDL/Verilodg)

Simulator: ISim (VHDL/Veriloo)

Preferred Language: WVerilog

Property 3Specification in Project File: Z3tore all wvalues
Manual Compile Order: false

VHDL Source Analysis Standard: VHDL-93

Message Filtering: disabled

Mare Info | « Back Finish

Cance
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* The foll

owing screen appears:

_181 %]
File Edit View Projsct Source Process Tooks window  Layout  Help
DXl l2rpr 2R A= SRl = £]19
Design +08x
visw: v {8 Implementation ¢ 5 Simulation

Hierarchy
- (3] Digital_design_lab_t
B €3 xc3s250e-4tg144

Empty View

The view currently contains no
files. You can add files ko the
project using the toolbar at left,
commands from the Project menu,
and by using the Design, Files, and
Libraries panels.

B B | | 8a [ B fin =L

Use:

*New Source: To create a
e source file,

*Add Source: To add an
existing File ta the project,

« Add Copy of Source: To
copy an existing File to the
profect drectory and sdd it 7|

#2 No Processes Running

Na single design module is sslscted,
¥ Design Utilties

EIEIEERD

o Start_ B Design | ] Files | () Libraries|

Console

! | _l‘I
Console rﬁ Errars | 1\ Warnings | a6 Find In Files Results

Define a box For zooming
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"™ ISE Project Navigator (P.68d) - C:'\Digital_design_lab_1'.Digital_design_lak

° TO gEt Sta rted’ rig ht CI iC k 0 n t h e File Edit Wiew Project Source : Process Tools “Window Lavouk Help

ID2E & - |l & I X |© e =

xc3s250e-4tq144 label, and select =N
New source... from the menu.

fr) (=]

Hierarchy:

| | Mew Source...
[=5| add Source. ..

The wiew currenkly conkains no !
=] Add Copy of Source. ..
files, %ou can add files bo the EJ B

project using the toolbar at left,
commands From the Project menu,
and by using the Design, Files, an
Libraries panels,

Empty Yiew

Manual Compile Order

= Implement Top Module

f||.t‘;ﬁ|l|§”|

ze: FilefPath Display 3

# hlew Source: To create a Expand All
niew source File,

« add Source; To add an
existing file to the project m Find... Chrl+F
* Add Copy af Source: To _
copy an existing file to the Cresign Properties. ..

project directory and add
ko the oroiect,

Collapse &ll
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* The following window appears:

Select Source Type

Select saurce bype, file name and its lacation,

Schernatic
dser Docurnent
Yerilog Module
Werilog Test Fixture
YHOL Module
WHOL Library
YHOL Package

a| WHODL Test Bench

~ Embedded Processor

File name:

Location:

I C:Digital_design_lab_1ipoore_dir

v &dd o project

Mare Info |

Mexk =

Cancel
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 Select Verilog Module
* File name: module_1

* Make sure the ‘Add to project’
checkbox is selected

* Do not modify the Location

* Press Next

" New Source Wizard

Select Source Type
Select source tvpe, file name and its location.

r. IP {(CORE Generator & Architecture Wwizard)
4] Schematic

=] User Docurnent

Werilog Module

] Werilog Test Fixture

] YHOL Module

File name:
™ WHOL Library
F] YHOL Package Imn:u:lule_ll
"] WHOL Test Bench
4 =5t BemC Locakion:

Embedded Processor

I C:Digital_design_lab_1

v add to project

Mare Info |

Mext =

Cancel
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* The New Source Wizard appears:

* Add to new ports: sw, Id

* Set the direction of sw to input

* Set the direction of |d to output

* Check the Bus checkbox for both ports

e Set the value of the MSB to 7, and the
value of the LSB to O for both ports

* Press the Next button

Define Module

Specify ports For module,

Madule name |module_1

Part MNarme

I K O K O K K K K K K

M
* ojoojojoojojooojs®E|s
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* The following window appears:

Summary
Project Mavigator will create a new skeleton source with the Following specifications.,

* Press Finish

Add to Project: Yes

Source Directory: C:\Digital_design_lab_1
Source Type: Werilog Module

Source Mame: module_1,v

Module name: module_1

Part Definitions:
A Bus: w0 inpuk
Id Bus: 1 oukpuk

Mare Info | < Back Finish Zancel
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* The ISE software generates the editable source file for the project:

ISE Project Navigator (P.68d) al_design_lab_1.xise - [module_1.v] =181 x|
) File Edt Wew Project Source Process Tools Window Layout Help =& x|
[DEE@ s sCxewal-lfrpx RAIZSno]lLe]lr= L]0
2esign coax € 1 ‘timescale 1ns / lps
[} view: & {5 Implementation © ] smuation =
] [ — 2 SEESSTEES SRS TR RS E RS RS EEES S SEEESS TR
jerarchy )
I i =] Digital_design_lab_t - 3/ Company.
S5 B £ xcasasve-dtglad 4 // Engineer:
S B imodule_1 {madule_1.v} 5 //
) sttt “| & // create Date:  16:02:03 03/14/20139
A 7 // Design Name:
@ % g8 // Module Name: module 1
— p. $ 9 // Project Name:
4| 10 // Target Devices:
6 11 // Tool versions:
12z // Description:
13 //
14 // Dependencies:
15 //
= 16 // Revision:
» | T2 MoPracesses Running 17 // Revision 0.01 - File Created
% Processes: module_t | 18 // Additional Comments:
By % Design Summary/Reparts 19 //
%g BEZ‘?ED”;;‘LT:;G 20 SASESSSTEEESS RS E S S S EEEESEESSE R SS R EESSEELEES P ES RS
| & T synthesize -xsT 21 module module 1¢
* 0 s mnrari 22 dnput [7:0 sw,
B Configure Target Device 23 output [7:0] 1d
Lg% analyze Design Using ChipScope 24 L
25
26
27 endmodule
28
4 | |
o Start G Design [ 1) Files [T Ubraries] | 3 Design Summary (Programming File Generated) ] Spartanak.ucf IE! module_1 v @
Srrors 08 x
=l
al I o

Console @) Errors [ 1\ Warnings [ 18 Findin Files Results
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* Now you can create your first “Hello World” module.

e After you have finished with the code, you can test your module on
an FPGA board:

* The FPGA itself is the black, square shaped
device in the middle of the board




Introduction to Verilog

* In this first design, you are going to control the LED panel of the FPGA
using the switches: if a switch is turned on, the corresponding LED will
light up.

switch panel
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 We need to define a connection between the LEDs and the switches
using Verilog. The aim is to connect them one-by-one.

* The LEDs are connected to the outputs (red wires) of the FPGA , while
the switches are connected to the inputs (blue wires).

* In the implementation, we will connect
these inputs and outputs “inside” the
FPGA
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* To do so, add the following line to your module:

1=z

20 J/SSSS 5SS SRS
21 module module 14

22 input [7:0] aw,
23 output [7:0] 1d
24 I

Zh

26 assign 1d = sw|
27

28 endmodule
R

* Don’t forget to press the save button &=
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* As a last step, you have to define the connection between your own
port names (ld and sw), and the port pins of the FPGA.

* Take a close look at the LEDs of the board. You can see the matching
of the LEDs and the corresponding ports of the FPGA. For example,
LDO is connected to P59, LD1 is connected to P58, and so on.

* The name of the leds in our module is Id, which is an 8 bit output. So
we have to define that Id[0] is connected to port P59, Id[1] is
connected to port P58, and the same for the rest of the leds (up to
1d[7], the 8t led).
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* The same definition has to be done also for the switches. Check the
lower right corner of the board.

* You can see the matchings between the switches and the input ports:
sw[0] is connected to port P101, sw[1] connects to P95, and so on.

* We need to provide this information somewhere in our project before
we generate the programming file and download it to the board.

* For this purpose, we have to add a .UCF file (User Constraints File) to
the project.
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"™ ISE Project Navigator (P.68d) - C:'\Digital_design_lab_1'.Digital_design_lak

° Right Cl ick O n IIXC3SZSOe_4tq 144’/ i n Fil= Edit Wiew Project Source : Process Tools ‘Window Lawout Help

. [D2E@| |ldDDX[0a|»
the top left corner of the ISE window, ~08 x

Yige: o I:l"i_} Implermentation € Sirnlation
and select New Source.

fr) (=]

Hierarchy:

| | Mew Source...
[=5| add Source. ..

The wiew currenkly conkains no !
=] Add Copy of Source. ..
files, %ou can add files bo the EJ B

project using the toolbar at left,
commands From the Project menu,
and by using the Design, Files, an
Libraries panels,

Empty Yiew

Manual Compile Order

= Implement Top Module

f||.t‘;ﬁ|l|§”|

ze: FilefPath Display 3

# hlew Source: To create a Expand All
niew source File,

« add Source; To add an
existing file to the project m Find... Chrl+F
* Add Copy af Source: To _
copy an existing file to the Cresign Properties. ..

project directory and add
ko the oroiect,

Collapse &ll
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" New Source Wizard

Select Source Type
Select source bvpe, file name and its location.

* In the next window, select

Implementation Constraints File

EMM File
I * £2 ChipScope Definiti di tian Fil
* File name: Spartan3E i

; IP (CORE Generator & Architecture Wizard)
MEM File

Do not edit the Location o) schemat

E Iser Document

verilog Module I Spartan3E

* Make sure the Add to project g et it

"] ¥HDL Module

checkbox is set 3 ot rorene
U] ¥HOL Test Berch
* Embedded Processar

* Press Next

v add ro project

W'. WHOL Library IC:'I,DigitaI_design_Iab_l e |

Mare Info | Mext = Zancel
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* On the next window, press Finish

W pew Source Wizard

Summary

Project Mavigator will create a new skeleton source with the Following specifications.

Add to Project: Yes

Source Directory: Ci\Digital_design_lab_1
Source Type: Implementation Constrainks File
Source Mame: Sparkan3E.uck

Association: module_1

Mare Info |

< Back

Finish

Cance|
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* Add the following lines to the UCF file:
° Note: Some Of the po rt na me S b_1'Digital_design_lab_1.xise - [Spartan3E.ucf]

dow Layouk  Help

1 » s 3 ™ [ S| B =y 2 T »
after LOC were replaced with 2,88 -,RIAImEDCl#R]r s L9
. 1 # 8 switches, from the left to the right
quest|on markS. o NET "sw<7>"  LOC = "D47";
9 NET "sw<6>"  LOC = "D4E";
. 4 HNET "sw<S>"  LOC = "PAI";
° E NET "sw<d>"  LOC = "777";
Check the board and define S NET swedsr o 10C - 17777
. . 7 NET "sw<Z>"  LOC = "DAOT;
the correct missing ports! B o Tos I
9 NET "sw<0>" LOC = "pl0l";
; 10
* Don’t forget to press the save 11 # 5 LEDs, from the left to the right

b tt 12 HNET "ld<7>" LOC = "Dpd43";
13 NET "ld<é>"  LOC = "DS0";
ution. H 14 NET "ld<5>" LOC = "297";
15 NET "ld<4>"  LOC = "D52";
16 HNET "ld<3»>" LOC = "DP53";
17 HNET "ld<Z>"  LOC = "p5d";
18 NET "ld<1>"  LOC = "DSE";

10 NET "ld<0>" LOC = "777"; |




view: ¢ J&} Implementation ¢ & Simulation

Hierarchy
""57] Digital_design_lab_1
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* Now you are ready to generate the
so-called programming file

* To do so, left click on module_1 in the
top left corner of the ISE
P2 Mo Processes Running

* On the lower side, the following (==

o] B Design Surmmary/Feports

OpﬂOnsappeaR L#% Desian Utilities

H B ser Constrainks
-| B 20D Syrthesize - ¥5T

* Right click on Generate programming file, and select | &0 cesenmmmrsre
-- -@ Configure Targek Device

R u n i n t h e po p u p m e n u R .- Analyze Design Using ChipScope
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* If everything was OK, you should see 3 check marks:

Processes: module_1

> = Design Surmary/Feports
[} Design Utilities
-- ser Conskraints
. PAC) syrthesize - ¥5T
. {} Implement Design
1 icenerate Programming File
. .-@ CDnFlgure Target Device
L@ Analyze Design Using ChipSoope

* Check your working directory, you should see a new file named
“module_1.bit".
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* However, if you see anything but the 3 check marks, ask for
assistance:

Processes; module_1

e H Design Summary [Reports
| = Design Litilities
-- ser Constraints
| = B2 Synthesize - 15T

- 821y Implement Design

- P2E) Generate Pragramming File
-- “1'5 Configure Targek Device

LB Analyze Design Using ChipScope
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* Before uploading the generated programming file, the board needs
some setup.

* First of all, connect the JTAG connector to the board. The labels (TDO,
TCK, CLK, MOSI, I/OREF and 5V) should be the oriented the same way
as on the following picture, otherwise you might harm the device!
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e Connect the USB cable to the JTAG connector.

* Launch the Logsys GUI application =]

] Legsys Control Panel
File View Window Help

LDC221 1 x
Info Configuration
LOGSYS development cable ITAG Download
LDC221
Control Communication

RST BitBang If0
CLK UART
10 He | set | USRT
Power
Voltage Current
5V OFf Maximum \l'.alue: 450 ~ mA
Log tofile...
Measurement

+5yout: 0.00 vy Maximum Value: 500 = mA
Loref: D.00 V Critical Value: 90 |2|%

JTAGref: 0,00 V Samples/Second: 10

e p oyl W

aseqeep
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* Press the +5V Off button "

* After pressing it, it turns into red: 7.
esvon |

* Select the JTAG download checkbox under Configuration: " x

Configuration
JTAG Download
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* The following options appear on the right side of the screen:

% Download (LDC221) | X

JTAG i : i
Devices in the JTAG chain:

[ Query JTAG chain

Clear Log

* Press the Query JTAG chain button, the “Configure the selected
device” button becomes active on the right.

* Press it, and browse the “module_1.bit” file from your working
directory.

» After selecting the file, press Open
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e After the programming is complete (green status bar), you can try
turning the LEDs on and off by flipping the switches.

* Try to set the following decimal and hexadecimal number assuming
LD7, LD, ..., LDO represent 27, 25, ..., 29:
* 68,
. 178,
* 68,
* C74



